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SUMMARY 

In this report we present a description of the research investigations directed toward the 
development of the Nuclear Effects Data Management and Analysis System (NEDMAS). 
In its current configuration, NEDMAS is applicable to above-ground nuclear explosions 
at the U.S. Nevada Test Site and encompasses an online database of approximately 1000 
pressure time series from 24 events in 3 series, as well as some preliminary fireball 
photography, cratering data, and ground motion data. Total data volume at the time of 
this report is about 6 MB. Information regarding the explosion source environment is 
presented to the analyst in the context of a SPOT® satellite image of the site surrounding 
the detonation point, together with associated surface geologic information and DMA 
topographic data. 

The capabilities and functionality of NEDMAS are illustrated in Section 2 using displays 
of the screens encountered by an analyst in a typical processing session. The selected 
capabilities displayed in this sample session are related to a more complete definition of 
the system functionality through references to a series of appendices containing a detailed 
script of the user actions required to reproduce the sample session (Appendix B); a 
complete description of all currently-available system options (Appendix C); and 
information regarding software and hardware implementation requirements (Appendix 
A). Taken together, Section 2 and its associated appendices provide a concise 
description of the results of the NEDMAS development effort. 

in 
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SECTION 1 

INTRODUCTION 

Over the past several years, the Defense Special Weapons Agency (DSWA, formerly the 
Defense Nuclear Agency [DNA]) initiated a series of efforts designed to provide improved 
access to its archive of nuclear weapons effects data. These efforts have included the creation of 
the Graybeard data review and evaluation panel (comprising nuclear weapons effects experts 
who participated in the United States' atmospheric nuclear testing programs) and several 
software and computer-based archive projects. Among the computer-based projects were the 
Nuclear Effects Data Management and Analysis System (NEDMAS), the subject of this report; 
and the Data Archival and Retrieval Enhancement (DARE) system. The NEDMAS project 
aimed to permit the user to access various data from aboveground tests via a graphical user 
interface, to make it possible to compare data between tests, and to allow comparison of 
observed data with modeled data. 

In its current configuration, the system is applicable to above-ground nuclear explosions at the 
United States' Nevada Test Site (NTS) and contains a database of approximately 1,000 pressure 
time series from 24 events in 3 series, as well as some preliminary fireball photography, 
cratering data, and ground motion data, comprising altogether about 6 MB of data, as received 
from DASIAC. In addition, it contains about 800 KB of data generated by a sophisticated finite- 
difference modeling application; approximately 100 megabytes of image data including 
photographs scanned from contemporary reports and a SPOT® satellite photograph of the test 
site; geologic data; and topographic information derived from DMA sources. Information is 
presented to the user in the context of SPOT® satellite images of the area immediately 
surrounding the detonation points at NTS. 

The user interface to the system has been designed to be completely menu-driven and mouse- 
activated and requires no keyboard entry by the user once the system has been started. This 
graphical user interface has been built using the X Window system; X was designed specifically 
to allow hardware independence, to foster ease in porting applications to machines other than 
those on which they were developed, and to permit running of applications on one computer 
while displaying their output on another, even if the computers are of different manufacture. 
NEDMAS was designed and implemented on Sun SPARC computers, but transfer to any other 
system that supports X Windows and UNIX could easily be accomplished. 

NEDMAS comprises a suite of applications. The front end is a program that performs most of 
the work of showing data in context and providing menu- and mouse-click access to pressure 
and other data. Auxiliary applications display recorded data, modeling results, and summaries of 
data. All the software has been written in C or FORTRAN. C was chosen because the 
application programmers' interface to X Window procedures is in C and because C is well suited 
to the design of complex systems with a variety of data structures. FORTRAN was used for 
certain legacy applications, particularly the modeling programs, with C and X front ends grafted 
on for purposes of displaying the results of the calculations to the user. Database functions are 
performed by procedures written as part of the NEDMAS effort. The database structure is 
compatible with commercial database management systems such as Oracle. 



This document provides a summary report of the initial development of NEDMAS. In the next 
section, the capabilities and functionality of the system are illustrated using captured screen 
images that would be encountered by a user in a typical session. A detailed script leading to the 
displays shown in Section 2 is provided in Appendix B. A comprehensive description of all 
NEDMAS controls and options is presented in Appendix C. 



SECTION 2 

OVERVIEW OF NEDMAS CAPABILITIES 

In this section, some of the capabilities and functionality of the Nuclear Effects Database 
Management and Analysis System (NEDMAS) will be illustrated through images of the 
screens encountered in a typical session. For this example, unclassified data from series 
Plumbbob events Smoky and Priscilla and series Teapot event MET will be examined to 
illustrate features of the system. A detailed script of the operator actions required to re- 
produce this sample session is provided in Appendix B. 
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Figure 2-1. General appearance of NEDMAS applications. 

The layouts of the NEDMAS application modules follow the pattern shown in Figure 2- 
1. The parts of the display are as follows: 

• menu bar - an area at the top of the display that contains buttons that cause menus to 
be displayed 

• message area - a strip just under the menu bar that displays short messages from the 
application 

• image area - the main display area of an application 
• side menu area - an area to the right of the image area that contains switches to 

control the functionality of the mouse. When a particular mouse function is selected, 
an indicator is illuminated next to the name of the function. 

All applications in NEDMAS use the same layout, though not all applications use all 
parts shown. 



We will present this overview of NEDMAS functionality by showing a series of screen 
images taken from a sample session. Each image has accompanying text describing the 
content of the screen. 

The initial NEDMAS display is reproduced in Figure 2-2; a compressed (70 meters per 
pixel) SPOT® image of NTS is shown in the context of the test site information interface. 
The main menu contains the menu-access buttons Effect, Series, Events, View, Data, 
Images Overlays, Function, and Help; and action buttons Copy and Quit. The Events, 
View Data and Images menus are context-sensitive; that is, they contain data relevant to 
the current state of the application  When the application is first launched, the Events, 
View, and Data menus are empty, but are filled in as choices are made. 
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Figure 2-2. Initial screen from NEDMAS. 



Before presenting the overview of NEDMAS, a description of the effects of the various 
menus on the main image display will be presented. Figure 2-3 shows the main 
NEDMAS menu and its submenus as they would appear after selections of Series and 
Event have been made. 

The Effect menu gives the user the ability to limit the type of data that will be accessed. 
When fully implemented, it will cause downstream menus, for example the Series Menu, 
to show only those series, events, and so on that contain data of the desired effect type. 

The Series menu allows the user to select which of the several available series of nuclear 
explosion tests is to be examined. When NEDMAS is first started, none of the Events, 
View, or Data menus contain any entries; the Images and Overlay menus contain a few 
items that are relevant to NTS as a whole as well as some images of general interest. 
Upon selecting a series, the context-sensitive menus fill in with items relevant to the 
series, and the locations of events from the series are shown on the SPOT® image of NTS 
as icons (red boxes with a center dot to indicate the detonation point). To proceed, the 
user selects one of the available Series from the menu. 

The Events menu is filled in with events from a particular series once a series has been 
selected. Contents of the menu are built from a database of events available to 
NEDMAS. To select an event, the user presses the Events menu button and chooses one 
of the listed events. Upon selection of an event, the context-sensitive menus fill in with 
data relevant to the selected event, while a green diamond outlines the location of the 
event on the SPOT® image. 
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Figure 2-3. The NEDMAS Main Image Display main menu, message area, and submenus. 

Once an event is selected, the View menu fills in with a set of views available for the 
chosen event. As currently configured, NEDMAS provides a full-resolution (lOm/pixel) 



SPOT® image of NTS immediately surrounding the event's detonation point, a color- 
coded topographic map of the area around the detonation point, and a general geologic 
map for NTS as a whole. Whichever view the user selects, the application displays the 
image and indicates the location of the event's detonation point with an icon. All views 
chosen in this way are registered to geographic coordinates, so overlaid icons may be 
displayed equally well on all views. 

The Data menu contains a list of available data for the selected event. Such data may 
include overpressure, dynamic pressure, total pressure, static pressure, Mach number, 
fireball photography, ground motion, and cratering data as available. Since all data types 
are not available for all events, only the relevant types are shown for a specific event. 
When the user selects a data type from this menu, locations of instruments that collected 
the data are shown on the image, represented by yellow boxes with center dots 
representing the instrument locations. The sample menu in Figure 2-3 shows a sample 
data menu as it would appear if all of the effects data types could appear at once. 

Images specific to the chosen event are accessible via the Images menu. The user may 
elect to view any image at any time by selecting one from the menu. After looking at the 
images, the user must restore the View by selecting the appropriate entry from the View 
menu. Selections having a right-pointing arrow on the item bring up a submenu. 

The Overlays menu gives the user access to digitized line data for the specified event. It 
also provides access to data digitized by the user, as discussed below. The final entry in 
each Overlay menu, called Digitized overlays, brings up a submenu containing overlays 
that have been constructed via the digitization feature of NEDMAS. 

The Functions menu is partly context-sensitive. That is, its contents do not vary 
according to the selections made in the Series and Events menus, but the data used in 
some displays depends on the selections. Its contents and their functions include: 
• Plot Pressures - plot pressures as recorded at selected instruments. 
• Plot Peaks - for the selected event, display a plot of Peak Pressure versus Range. 
• Plot Times - for the selected event, display a plot of Arrival Time versus Range. 
• Plot HOB - for the selected event, plot scaled height-of-burst versus scaled range. 
• Priscilla Airblast Calculation - present graphical results of an off-line finite difference 

calculation for series Plumbbob event Priscilla. 
• Save Overlay - this provides a mechanism by which the user can save digitized 

overlays. 

The Copy button on the Menu Bar captures the image to a file. When the user presses 
this button, a dialog box asks for the name of a file to which the screen image is to be 
saved. Screen images are saved to whatever directory the user was in when NEDMAS 
was launched in a form suitable for output to a printer. 

The Help menu provides access to a series of pages of text describing how to use every 
NEDMAS application 



Pressing Quit causes the application to terminate execution. 

Finally, the menu along the side of the main image display controls actions that take 
place when the mouse button is pushed. 

In this example, we will select Series^Plumbbob and Events^Priscilla to generate a 
display like Figure 2-4, showing the locations of all the events of the Plumbbob series 
with the Priscilla event, in the south-central part of the image, highlighted by a diamond. 
The area immediately around the selected event can be shown in various ways by 
accessing the View menu; the choices are a SPOT® image at full 10 meter resolution, 
color-coded elevation, or color-coded surface geology. 
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Figure 2-4. Series Plumbbob with event Priscilla highlighted. 



Figure 2-5 shows the full-resolution SPOT® image surrounding the detonation point of 
series Plumbbob event Priscilla. The detonation point is indicated by the square at the 
center of the satellite image, shown here in white but in color on a computer display. 
Within NEDMAS, all events have associated full-resolution satellite images centered 
around the event's detonation point. 

Effect   Series   Events   View   Data   Images   Overlays   Function    Copy   Help   Quit 
Mscflla (GlS-GEOSPOT Level "3a" Panchromatic Image, 10.0 M x 10.0 M Resolution) 

Figure 2-5. Full-resolution satellite image of area near Plumbbob/Priscilla. 



The image display will respond to mouse clicks according to the state of the mouse- 
action buttons in the side menu. With the information toggle chosen, placing the mouse 
cursor into the box indicating the detonation point of any event will cause an information 
box to appear, as shown in Figure 2-6. Most objects that appear in NEDMAS displays 
can be queried in this way. 

feEfSKML" I3E 
Effect    Series   Events   View   Data    Images    Overlays   Function   Copy   Help    Quit 

Priscilla (GIS-GEOSPOTLevel"3a" Panchromatic Image, 10,0Mx 100Mfossolution) 
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Figure 2-6. An information dialog box. 
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Other functions of the mouse include magnifying the display, taking cross-sections 
through the elevation data, digitization of features that are visible on the display, 
selection of data-collection stations for examination, and latitude and longitude of 
selected points. One selects a function for the mouse by clicking on the function's name 
in the side menu, then exercises that functionality by clicking in the image area. For 
example, Figure 2-7 shows a magnified version of a portion of the display of the SPOT® 
image around the Sedan crater, achieved by selecting Magnify from the side menu, then 
clicking near the center of the crater visible in the image. 

kiiMaJääSMKiSlLLx^. 
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< Figure 2-7. A magnification of part of a satellite photo. 
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Often there are photographs and images from reports associated with particular events. 
The Images menu will contain the list of images available for a particular event under 
examination  For event Smoky, one available image from that menu (Images=>Aenal 
Photos^Southeast to Tower) is shown in Figure 2-8. This image is a photograph taken 
prior to the Smoky explosion, looking from the northwest toward the tower used to house 
the Smoky device; notice particularly the hill visible in the foreground. 

Effect    Series   Events   View   Data   Images   Overlays   Function    Copy   Help   Quit 

Smoky - Southeast to Tower 

Figure 2-8. Pre-detonation photograph near Plumbbob/Smoky. 
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Topography is viewable in several ways. One way to view it is to take a cross-section 
along a line specified by two mouse clicks, as shown in Figure 2-9. In this cross-section 
the hill that was visible in the foreground of Figure 2-8 is shown in profile. Another way 
to show topography is to display a color-coded topographical map, by selecting 
View=>Topographic data from the main menu bar. 
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Figure 2-9. Cross-section along a line SE-NW near Plumbbob/Smoky. 

A third way to view topography is as a 3D wireframe display, as shown in Figure 2-10. 
Here, the view is from the southeast toward the hillside, i.e., almost opposite the 
viewpoint of Figure 2-8; the hillside is visible as a rise in the background of the 
wireframe. 
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Figure 2-10. Wireframe image of hillside near Plumbbob/Smoky. 

A central feature of NEDMAS is that it permits the user to examine data from NTS 
atmospheric explosions by means of a graphical interface.   Once series and event have 
been chosen the user can display locations of instruments that recorded data available on 
the system by making a selection from the Data menu. In Figure 2-11, the overpressure 
data locations for series Plumbbob event Smoky are shown as light-colored boxes 
surrounding the detonation point. 

14 
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Figure 2-11. Satellite photo of Plumbbob/Smoky area, showing detonation point and instrument 
locations. 

One selects instruments whose data are to be displayed by choosing Select Station from 
the side menu, and then clicking on the locations of individual instrument locations. 
Comparing Figures 2,-11 and 2-12, one can see that selected instrument locations in the 
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northwest-trending instrument line have been flagged by colored diamonds, indicating 
that those instruments have been selected for display of data. Similar access to data is 
provided in cross-section displays provided the user has specified a cross-section line that 
intersects the locations of data collection points; such a case is shown in Figure 2-9, 
where the boxes on the ground profile represent instrument locations. 

Effect   Series   Events   View   Data   Images   Oveilays   Function   Copy   Help   Quit 

Figure 2-12. Instruments selected from Plumbbob/Smoky. 
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Once instruments have been selected, one may view the data collected at those stations 
by choosing Function^lot Pressures from the main menu bar. Figure 2-13 shows 
several overpressure waveforms from the Smoky event along a line northwest of the 
detonation point. The pressure waveform display will show an arbitrary number of 
waveforms, but imposes a minimum size limit so that at most six waveforms will be 
visible at one time; if the number of time series to be displayed is greater than that, a 
slider will appear at the right of the display that allows the user to scroll the display to 
view waveforms that are not visible initially. Switches in the display allow the user to 
look at the data as individually scaled waveforms, or as a set of waveforms that are 
scaled to a common vertical scale; to select a waveform to move around the screen to 
overlay on other waveforms for comparison; to show measurements in original units or 
in standard SI units; to scale all waveforms to a standard explosion size and atmospheric 
pressure; to view waveforms either as instantaneous overpressure (in units of pressure 
versus time) or as cumulative impulse (in units of pressure-seconds versus time); and to 
perform time series modeling using the Brode (Brode 1986) or LAMB (S-Cubed 1983) 
modeling codes. 

Predict Options  Tools Refresh Copy Help Quit 

PLUMBBOB, SMOKY (W = 43.7M, HOB = 700ft), Overpressure (psi) 

Figure 2-13. Overpressure data from selected Plumbbob/Smoky instruments. 
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Just as topography was viewable in several ways, so are the pressure data displayable in 
different formats. Besides the pressure versus time waveforms discussed previously, 
pressure data may be displayed as peak pressure versus range of instrument from the 
detonation point, as shown in Figure 2-14, and as arrival time versus range, as shown in 
figure 2-15. 

Units Refresh Copy Help Quit 
PLUMBBOB, smoky (W = 43.7kt, HOB = 700ft), Peak Pressure (psi) 

iStöigaasiröäiiaWäSftn^^ 

Figure 2-14. Peak pressure versus range for Plumbbob/Smoky. 
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Units Refresh Copy Help Quit 

Figure 2-15. Pressure arrival time versus range for Plumbbob/Smoky. 
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Oftentimes a user will want to compare data, and NEDMAS provides a mechanism to do 
that. One way to start a data comparison is via the satellite image display. Figure 2-16 
shows series Teapot event MET with overpressure instrument locations shown. For 
Teapot/MET, the three lines of instruments were installed respectively on the desert 
surface, on a'runway-like strip of asphalt, and on a long, wide water-filled trench; in 
Figure 2-16, these three lines of instruments are represented by differently-colored 
perpendicular lines of icons. With side menu item Compare selected, the user clicks on 
one instrument location to choose it for displaying data and other instrument locations for 
that event at similar distances are chosen automatically by the application. Invoking 
Function=>Plot pressure will then show the time series recorded along all three 
instrumentation lines. 

Efifect   Series   Events   View   Data   Images   Overlays   Function   Copy   Help   Quit   { 
MET, fari,radius 2000.00 ft, azimuth 270.00, tieigMftgg^Lg^^SlS^, 

Figure 2-16. Teapot/MET, showing instruments for comparison of overpressure along different 
instrument lines. 
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Figure 2-17 shows data from the selected instruments from Teapot/MET, scaled to a 
common vertical scale, with pressure in units as recorded (PSI). The topmost time series 
in the figure is from an instrument on the desert floor at 2000 feet from the detonation 
point; the middle time series is from an instrument at the same distance on the asphalt 
surface; and the bottommost time series is from an instrument at the same distance in the 
water-filled trench. Viewing the data this way permits the user to examine the effects of 
surface environment on pressure from an explosion. 

Predict Options Tools Refresh Copy Help Quit 

TEAPOT, MET (W = 22.0W, HOB = 400ft), Overpressure (psif 

Figure 2-17. Data from three lines of Teapot/MET. 

The application that displays pressure data also gives the user access to certain modeling 
capabilities. Once the user has selected a particular event, one can invoke models based 
on Brode (Brode 1986) and LAMB (S-Cubed 1983) that are computed in real time 
according to the parameters of the explosions that produced the selected waveforms. The 
user can adjust certain parameters of the modeling programs (yield in kilotons and 
height-of-burst in feet for the Brode model, and those parameters plus height-of- 
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instrument in feet for the LAMB model) via dialog boxes that appear when modeling is 
started. A sample of Brode (Brode 1986) computed pressure data overlaid on the 
observed data displayed above is shown in Figure 2-18. 

Predict Options Tools Refresh Copy Help  Quit 

"TEAPOT, MET (w = ^<^'^li^'^^}i2!iSSS^^J^Z^^^. 
Hange - üoouft 
Az-liuith      270de 
m-iyhi   - "fi 
Desert.   EBL 

A nh 

/     \ 

Figure 2-18. Data from Figure 2-17 with Brode modeling results overlaid. 
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Additionally, more elaborate calculated pressures developed for the series Plumbbob 
event Priscilla, from a detailed finite difference calculation carried out using the SHARC 
code (Needham et al. 1994), are available for overlay. These calculations were 
performed off-line. Figure 2-19 shows selected time series from Plumbbob event 
Priscilla with SHARC modeling results overlaid. 

Predict  Options Tools Refresh Copy Help Quit 

 ^,.^Ä^^^^ 

Figure 2-19. Data from Plumbbob event Priscilla with SHARC modeling results overlaid. 
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For comparison, Figure 2-20 shows the same time series shown before but with Brode 
(Brode 1986) modeling results overlaid. It is immediately apparent from a comparison 
of Figures 2-19 and 2-20 that the SHARC non-ideal airblast simulation provides a much 
better fit to these data than does the simplified Brode model. 

Figures 2-19 and 2-20 also illustrate the capability of the time series display program to 

show data in SI units. 

Predict Options Tools Refresh Copy Help Quit 
PLUMBBÖB, PWSOLLA <W=~ 36.01,HOB = ^l^Owxp^w^J^^ 

Figure 2-20. Data from Plumbbob event Priscilla with Brode modeling results overlaid. 
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Individual waveforms are not the only type of output from SHARC that is available for 
display within NEDMAS. Figure 2-21 shows the computed velocity vectors in air at a 
range of 475-725 m from the detonation point, 600 msec after the detonation. The 
complicated regions of airflow associated with the pressure front resulting from nuclear 
explosions can be seen clearly, particularly in the color display that is shown on the 
computer monitor. 

Series   Events   View   Data   Images   Overlays   Function   Copy   Help   Quit 
PrisdJla 

Figure 2-21. SHARC velocity vectors display. 
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Another method for comparing time series is available from the pressure plotting 
application. Given a display containing a suite of waveforms from a particular event, the 
selection of Tools^>Compare and clicking on a particular waveform will bring up a 
dialog box of data from events in the database of similar scaled yield and range, where 
all numbers are scaled to a standard-sized explosion at a standard atmospheric pressure. 
One selects one or more matching events from the dialog box, which starts another copy 
of the waveform plotter showing waveforms from several events that match. This series 
of illustrations starts with Figure 2-22; it shows the instrument locations from series 
Plumbbob event Smoky, with several instruments at similar distances selected, as shown 
by colored diamonds overlaid on the instrument location icons. 

Effect   Series   Events   View   Data   Images   Oveilays   Function   Copy   Help   Quit 
SMOKY, fafl, rafflns 196fe00 ft, arfnrntn^^lH^ 

Figure 2-22. Plumbbob/Smoky instrument locations for time series comparison. 
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Next, the time series recorded by these instruments is shown in Figure 2-23, so that the 
overpressures along different kinds of topography can be compared. 

Predict  Options Tools Refresh Copy Help Quit 

^«,^£22°iSS2Sy(W = 43-71kt' HÖB™7ÖC«r6ve^ressi^"(psii" 

lUnye   =   lx:-I()fl 
rtzinutli -  332tle 
llfialil   - of I 
Desert.  Er.L l!   / \\'JS^^-^rr^'' 

Figure 2-23. Data from selected instrument locations, Plumbbob/Smoky. 
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Finally, Figure 2-24 shows the third time series from Figure 2-23 compared to data from 
other events at similar scaled yields and distances. 

Predict  Options Tools Refresh Copy Help Quit 
Ö^äpressure: scaled HOB = 199 + - 10K, scaled «ange^573j^ 10%, (ft/M**jLg^ 

Figure 2-24. Time series from Plumbbob/Smoky compared to similar scaled events and instrument 

ranges. 
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Another method within NEDMAS for comparing data from different events is by the 
display shown in Figure 2-25. This shows, as background, pressure as a function of 
range and height-of-burst as calculated by the Brode model (Brode 1986) for a standard 
event yield and atmospheric pressure shown in color. On top of the background are 
shown color-coded boxes; each event occupies a horizontal line corresponding to its 
scaled height-of-burst, while the color in the box shows the scaled measured 
overpressure. 

Copy   Help   Quit 

HOB vs Range, Ikt Burst, Maximum Overpressure 
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Figure 2-25. Scaled range versus scaled height-of-burst for all events. 

29 



SECTION 3 

CONCLUSION 

In this report we have presented an in-depth description of the research investigations directed 
toward the development of the Nuclear Effects Data Management and Analysis System. In its 
current configuration, NEDMAS is applicable to above-ground nuclear explosions at the U.S. 
Nevada Test Site and encompasses an online database of approximately 1000 pressure time 
series from 24 events in 3 series, as well as some preliminary fireball photography, cratenng 
data, and ground motion data. Total data volume at the time of this report is about 6 MB. 
Information regarding the explosion source environment is presented to the analyst in the 
context of a SPOT® satellite image of the site surrounding the detonation point, together with 
associated surface geologic information and DMA topographic data. 

The capabilities and functionality of NEDMAS were illustrated in Section 2 using displays of 
the screens encountered by an analyst in a typical processing session. The selected capabilities 
displayed in this sample session were related to a more complete definition of the system 
functionality through references to a series of appendices containing a detailed script of the user 
actions required to reproduce the sample session (Appendix B); a complete description of all 
currently-available system options (Appendix C); and information regarding software and 
hardware implementation requirements (Appendix A). Taken together, Section 2 and its 
associated appendices provide a concise description of the results of the NEDMAS development 

effort. 

Under an ongoing follow-on effort, Maxwell Technologies Inc. is continuing the development of 
the NEDMAS nuclear effects software system with the primary objective of integrating it into 
the new comprehensive DSWA DARE archival database of reports, photos, test data, and films 
related to nuclear weapons effects. More specifically, this effort is being used to develop 
generally applicable procedures and software that will facilitate the implementation of other user 
application interfaces to DARE. A prototype version of NEDMAS has recently been installed 
on the operational version of DARE running at the DSWA headquarters computer center and is 
currently accessible to DARE users having UNIX workstations. 
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APPENDIX A 

REQUIREMENTS AND STARTUP INSTRUCTIONS 

Al HARDWARE REQUIREMENTS. 

NEDMAS was developed initially on Sun SPARCStations running SunOS 4.1.x, then 
was moved to SunOS 5.x, also known as Solaris 2. The current version runs on a 
SPARCStation 20 under Solaris 2.5. The machines used to develop the system all had a 
minimum of 32MB of resident memory. NEDMAS uses the standard Sun 8-bit color 
monitor with a resolution of 1152x900 pixels and also uses the standard Sun three-button 
mouse. As currently configured, NEDMAS occupies about 500 MB of hard disk space. 
When run over a network, it has run successfully on several vintages of Sun computers as 
well as a standard Windows 95 computer with a screen large enough to display the 
application and a commercial X server. 

A.2 SOFTWARE REQUIREMENTS. 

NEDMAS is written in C and FORTRAN and uses the X Window System version 11 
release 5 and the Motif release 1.2 widget set. It has been compiled successfully using 
the GNU C/C++ compiler, versions 2.5 and later, and the Sun FORTRAN compiler. 
Without special modification, NEDMAS has been run over the World Wide Web via a 
set of CGI scripts under Netscape Navigator 2.0 and later. 

A3 STARTUP INSTRUCTIONS. 

The procedure used to launch NEDMAS varies somewhat according to the platform 
being used. Platforms available at the time of this report are a UNIX workstation 
running the X Windows system, both on a local machine and over a network; and a 
World Wide Web-style browser on a machine with X Windows capability connected to a 
UNIX workstation. Whichever launching path is applicable to a particular installation, 
the first NEDMAS display you will see will be a title page. 

NEDMAS can be launched with an optional demonstration script on the screen, as shown 
in Appendix B, Figure B-l. To launch that version, substitute the command 
nedmas script for the command nedmas as shown below. 

To launch NEDMAS on a UNIX workstation running X Windows, displaying on the 
same machine: 

1. change directory to the NEDMAS home directory. 
2. execute the initialization script "Init" under the C-Shell. 
3. launch the application. 
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Example: 
Assume NEDMAS resides in a directory called "/data/d/NEDMAS". 

prompt>  cd /data/d/NEDMAS 
prompt>  source  Init 
prompt > nedmas  & (or nedmas_script  & for scripted version) 

To launch NEDMAS on a remote UNIX workstation running X Windows, but displayed 
on a local machine: 

1. open a terminal window on the local machine. 
2. command the local machine to permit remote machines to display X Windows 

output. 
3. login to the remote machine on which NEDMAS will be executed. 
4. on the remote machine, change directory to the NEDMAS home directory. 
5. on the remote machine, execute the initialization script "Init" under the C-Shell. 
6. inform the remote machine that X Windows output is to be displayed on the 

local computer. 
7. launch the application. 

Example: 
Assume Los Angeles is the name of the remote computer on which NEDMAS will run 
and that New York is the local machine on which X Windows will display application 
output. As before, NEDMAS resides in "/data/d/NEDMAS". Prompts on the two 
machines are indicated by the machine name followed by a ">". 

on NewYork:     launch an xterm 
NewYork> xhost  + 
NewYork>  telnet LosAngeles 

Trying 123.456.78.90... 
Connected to LosAngeles. 
Escape character is   *A]'. 

SunOS UNIX (LosAngeles) 

login:  myname 
Password:  ******** 
Last login:  ... [more output from remote computer 

LosAngeles] ... 
LosAngeles> cd /data/d/NEDMAS 
LosAngeles> source Init 
LosAngeles> setenv DISPLAY NewYork:0.0 
LosAngeles> nedmas & (or nedmas_script & for scripted version) 
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To launch NEDMAS via a World Wide Web-style browser on a machine with X 
Windows capability connected to a UNIX workstation: 

1. launch a web browser application on the local machine. 
2. connect to the web server that hosts NEDMAS and navigate to the NEDMAS 

homepage. 
3     optionally, look at an overview of NEDMAS by selecting the hyperlink An 

Overview of NEDMAS. 
4.    follow the instructions on the webpage to launch NEDMAS. Both scripted and 

normal versions are available. 

A4 SHUTDOWN INSTRUCTIONS. 

To shut down NEDMAS: 
• Choose Quit from the main menu of all open NEDMAS applications. 
• If running under X over a network, the user can shut down X. The precise details 

vary according to local convention, but generically are as follows: 
0   Point to the "desktop" (i.e., outside any application window) and press the mouse 

button that brings up the system control menu; this often is the left mouse button. 
0   Move the pointer to the menu item Exit X Windows, stop, then move the pointer 

to the right onto the item Select If You 're Sure and release the mouse button. 
• If running via a World Wide Web browser, select Exit from the File menu of the 

browser to terminate execution of the browser. 
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APPENDIX B 

A SAMPLE SESSION WITH NEDMAS 

In this appendix, we present a script listing the actions necessary to duplicate a sample 
session with NEDMAS. 

One feature of NEDMAS is its ability to display an on-screen demo script to allow the 
neophyte user to become familiar with the application. Figure B-l shows the NEDMAS 
display with the on-screen script showing. The user scrolls down the script while 
working through the application. The text appearing below is the text of the online 
demonstration script. 

Quit Effect   Series 

C3/9/96> 

(1> Start pfoiram. 
After the title page 
appear»,  click anyuhare 
in the window to obtain 
the user- interface, 
»hoviinj * conp-HaM 
<i.e.,   7«  m  resolution) 
SPOT satellite inare öf 
UTS. 

CZ> Brow** top ¥ 
button*.  Not« that 
EUENTS,  VIBi and DATA 
ptinui are ewpty until  a 
series and event are 
selected, 

C3) Seleot 
SERIES^'Pluwbbnb" and 
EVENTS/'SBoky"; note 
diamond hiehlieht around 
Smoky location box. 
Click in 6n»okH location 
bo* to get Information 
pace.    Select 
EVEHTS/'Hood- art oliok 
in highlighted location 
to cat multiple evert 
selection menu.     Seleo 
"Hood" and then "OK" 
jet Hood information 
page. 

<4) Seleot 
EWENTS/'Sncky" and then 
VIEW/"SPOr  im«*»,   Swoky 
to obtain 10 * f  
resolution SPOT 

surroundinj the 
Smoky  detonation foir 

Events   View   Data   Images   Overlays   Fwctiaa   Copy 
GIS-GEOSPÖTScene, JPanctoomallc Image, yTS{resaittpled 7x) 

**# Quit 

(S) Sllei 
fro« the side menu, 
»djuat the 
"Magnification" slider 
to S and click in ceni 
of Sedan crater which 

Quit Magnified I»B£#, <i 
Hove  "Majnification" j] 
slider to 4 and again ii 
click in canter of Sedan 
crater.    Adjust 
"Contrast" and 
"Bri|htne**" thoiri on 
side mem to reverse 
contrast and increase 
brightness.     Quit 
»aem* 
click ■Ccn! 

ip and 
itrast"   a 

Brightness" 
return to original 

(65 Seleot "Lat/lon" 
frc* side IWIU.     Click 
in center of Secfcin 
crater and rot* latitude 
and lonritude of that 
point displayed on the 
information lint. 
Select "Digitize"  Fro« 
side ww and then click 

♦ Information 

•v IMflpn 

^Select Station 

-^Compare 

v Digitize 

V CKJM sec 

vRotatflble 
CK>«S «fee 

v Magnify 

Brightness     [ 

Figure B-l. NEDMAS startup screen and on-screen script. 
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Screen displays resulting from the actions described here appear in Section 2. 

(1)       Start program. After the title page appears, click anywhere in the window to ^ 
obtain the user interface, showing a compressed (i.e., 70 m resolution) SPOT 
satellite image of NTS. 

Effect   Series   Events   View   Data   Images   Overlays   Function   Copy   Help    Ojdt 

GIS-GEOSPOT Scene, Panchromatic image, NTS (resampted 7x) 

Figure B-2. Main menu and information line. 

(2) 

(3) 

Browse top menu buttons. Note that EVENTS, VIEW and DATA menus are 
empty until a series and event are selected. 

Select EFFECT/"Airblast", SEPJES/'Tlumbbob" and EVENTS/"Smoky"; note 
diamond highlight around Smoky location box. Click in Smoky location box to 
get information page. Select EVENTS/"Hood" and click in highlighted location 
to get multiple event selection menu. Select "Hood" and then "OK" to get Hood 
information page. 

Effect j 
Nuclear Effects selection 

Series j 
Series selection 

Events | 
Event selection 

View j 
View selection 

SPOT image, MET Airblast Hardtack 
Plumbbob 
Teapot 

Apple I 
Apple n 
Bee 
Homet 
Met 

Topographic data 
Geologic data 

Ground Shock 
Cratertag 
Fireball Tumbler 

Upshot-Knothole 
Small Boy 
Sedan 

Moth 
Post 
Tesla 
Turk 
Wasp prune 
Zucchini 

Figure B-3. Sample Effect, Series, Events, and View menus. 

(4) Select EVENTS/"Smoky" and then VIEW/"SPOT® image, Smoky" to obtain 10 
m full resolution SPOT® image of area surrounding the Smoky detonation point. 
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(5)      Select "Magnify" from the side menu, adjust the "Magnification" slider to 2 and 
click in center of Sedan crater which is located SE of Smoky. Quit magnified 
image, move "Magnification" slider to 4 and again click in center of Sedan crater. 
Adjust "Contrast" and "Brightness" sliders on side menu to reverse contrast and 
increase brightness. Quit magnified image and click on "Contrast" and 
"Brightness" labels to return to original settings. 

i  •'."-"Contra« ■:■"' f ♦ Infoivn&tlon 

V teflon ! - Säghtnewi    j 

it _oc- r- 
v Select Stauen 

\r Compare 

vDigltl» 

.vCftostiec 

^RotatnWe 
Crass a« 

"V Magnify 

Figure B-4. Side menu and Contrast/Brightness controls. 

(6)       Select "Lat/lon" from side menu. Click in center of Sedan crater and note latitude 
and longitude ofthat point displayed on the information line. Select "Digitize" 
from side menu and then click sequentially on a few points representing a closed 
outline boundary of Sedan crater. Select OVERLAYS/"Digitized overlays" 
/"Current" to overlay the digitized crater outline. Select FUNCTION/ "Save 
overlay" and move the cursor into the entry line of the dialog box. Type Sedan_ 
Crater and then "Cancel" the box without saving. Select VDEW/"Geologic data" 
and then OVERLAYS/"Digitized overlays'VCurrent" to show outline of Sedan 
crater on geologic map of NTS. 
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Overlays j 
Overlay selection 

IMet Overlay 
West to Tower 
Northeast to Asphalt 
North to Asphalt 
Northeast to Water 
South to Water 
Digitized overlays I Digitized overlays 

Current 

Function [ 
Function selection 

MET Firebaffl Bhtots ^ 
PrtsclUa Atrhlast Calculation 
Smoky J-D Topography 
Sedan 3-D Topography 
Plot pressures 
Hot peaks 
Plot tunes 
Bot HOB 
Save overlay     "-.   ':;,■'•■"     ' 

Figure B-5. Sample overlays menu with submenu and Function menu. 

(7)       Select VIEW/"Spot image, Smoky" and then DATA/ "Overpressure" to overlay 
Smoky overpressure instrument locations on the SPOT® image. Select 
MAGES/"Smoky detonation," IMAGES/"Aerial photos"/North to tower,".../ 
"Southeast to tower." Select IMAGES/"Instrumentation"/"Overpressure gage 
assembly,"...,/"Dynamic pressure gage installations." 

Data j 
Data selection 

Overpressure 
Dynamic Pressure 
Total Pressure 
Static Pressure 
MacbNimber 

Image selection 
Aerial Photos 
Atrhlast Schematic 
Instrumentation 

Aerial Photos 
West to Tower 
Northeast to Asphalt 
North to Asphalt 
Northeast to Water 
South to Water 

Figure B-6. Sample Data menu and Images menu with submenu. 

(8)       Select VIEW/"Topographic data" to show color-coded topographic image of the 
Smoky site. Select OVERLAYS/"Digitized overlaysTCurrent" to outline Sedan 
crater location. Select "Cross sec" from side menu and sequentially click on point 
south of Sedan crater and on point north of crater. Quit the cross-section display. 
Select "Rotatable Cross sec" from side menu and sequentially click on point in 
center of crater and on point north of crater. Quit the cross-section display and 
move the "Xsec Rotation" slider to 90 to obtain EW profile through crater.   Quit 
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the cross-section display. Select "3-D Topography" from the FUNCTIONS menu. 
Click on "Cycle" button. Dismiss viewing angle pop-up window. Select 
VIEW/"Topographic data." Select "cross sec" from side menu and sequentially 
click on a point SE of the event location and on a point in the region of high 
topography along the trend of the NW instrumentation line. Click on box at top of 
tower and note Smoky event information displayed on information line. Quit the 
cross-section display. 

State    Function   Copy   Help    Quit 
i 

State j 
Select mouse action 1 
Information            j 
Select station           j 

Function j 
Invoke a function j 
Plot pressures      \ 

Help j 
Select a help page 
Overview 
State Menu 
Function Menu 
Copy button 
Quit button 

Figure B-7. Crosssec main menu, message line, and pulldown menus. 

(9) Sequentially click on a point west of the event location and on a point beyond the last 
station on the eastern most (NE) line. Select STATE/" Select station" from cross- 
section menu and click once on a station location to view station data on the 
information line. Click twice on each station location to select for display. Select 
FUNCTION/"Plot pressures" from cross-section menu to obtain an Analyst Station 
display of the selected station overpressure waveforms. Scroll through waveforms. 
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Predict  Options Tools Refresh Copy Help Quit                                                       i 
PLUlVffiBÖB/sMOKYJW = 43^7WL 

Predict]                           Optionsj 
Model     j                         Sei?« °Ptlon_    ..j 

Brode (1988)|                  ^?^^e ^^??1 I—1 
Lamb (1990) j                   ™ä ScaltöS         ' | 
Non-Ideal    j                   Units                         j 

Trace Type            .- < 

Optionsj 
Select Option 

HOB = 700ft), Overpressure (psi) 

Tools! 
Select Tool) 
Expand     j 
Clone        J 
Measure    \ 
Compare   j 
Plot Peaks j 
Plot Times) 
Plot HOB   j 

Options! 
Select Option 

Amplitude Scaling,- 

Help] 
Help        | 

Overview        I 
Predict Menu   j 
Options Menu j 
Tools Menu     ] 
Refresh Button! 
Copy Button    | 
Quit Button     j 

: ■" 

Yield Scaling 
No Scaling 
Wl/3 

Yield Scaling             Relative               j 
Units                        Absolute 
Trace Type               1 

Units 
Trace Type 

Options! 
Select Option 

Amplitude Scaling, 
Yield Scaling 
Units 

»   Trarf Typ° 

Options! 
Select Option      j 

Amplitude Scaling    1 
Yield Scaling            | 

I \ 

1 Units           f            Units 
Trace Type                Original (ft.psl) 

Standard (mjcPa) 

-4  
~_ Select Type] 

Pressure   j 
Impulse      j 

Figure B-8. Analyst Station main menu, message area, and pulldown menus. 

(10) Select 0PTI0NS/"Units7"Standard (m,kPa)" from Analyst Station menu to 
convert display units from ft/psi to m/kPa. Select OPTIONS/ "Amplitude 
Scaling"/" Absolute" to convert all displays to the same amplitude scale. Select 
OPTIONS/" Yield Scaling"/" W 1/3" to cube root scale the data to 1 kt at sea level 
in a standard atmosphere. Select OPTIONS/"Trace type"/" Impulse" to convert 
overpressure waveforms to impulse versus time. Select OPTIONS/"Trace 
Type'V'Tressure" to replot original overpressure waveforms. 

(11) Select TOOLS/"Expand" and click on any trace to view expanded waveform. 
Select TOOLS/ "Measure" and click on any point on the expanded trace and note 
the corresponding time and amplitude values displayed on the information line. 
Select PREDICT/"Brode" and click on "Apply" button in Brode dialog box to 
overlay Brode prediction on observed waveform. Move the Brode yield slider to 
30 kt and "Apply." Select PREDICT/"Lamb," move Lamb slider to 30 kt and 
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"Apply." Quit the expanded waveform display to return to the original Analyst 
Station display. Select PREDICT/"Brode," move yield slider to 30 kt and 
"Apply." Scroll through waveforms to compare predicted and observed. Quit 
Analyst Station and then Quit cross-section display to return to main menu. 

lÜSZ&SSjBälimmFBB^^HH      H3 
Select parameters for Brode model 

43.7 
i -J,.J 

Yield(kt) 

700 
f •j-j 

HOB(ft) 

AW$Y\ Cancel! Helpj 

l2<tt2£2!ZZiHIIIMHHMHHHMqp|BJpT:3 
Select parameters for Lamb model 

43.7 
f 

Yield(M) "' 
700 

HOB(ft) 

0 
■    i 

Height(ft) 

ite^d Cancel! Susi 

Figure B-9. Sample Brode and LAMB control dialog boxes. 

(12)     Select FUNCTION/"Plot peaks" to view reported Smoky overpressure peaks 
versus range. Click on one of the peak amplitude boxes to get information about 
that data point. Quit the peak display and select FUNCTION/Tlot times" to view 
Smoky overpressure arrival times versus range. Quit arrival time display. 

Units Refresh  Copy Help Quit 

J™*BgPJ- smoky (W = 43.7kt, HOB = 700ft), Peak Pressure (psl) 

Units 
Units | 

OrignalJftjpsi)_J 
Standard (mjd>a)| 

Jferpj 
Help        | 

Overview        J 
Units button    | 
Refresh button 
Copy button 
Quit button 

Figure B-10. PlotPeaks and PlotTimes main menu, message line, and pulldown menus. 

(13)     Select VIEW/"SPOT image, Smoky" and side menu "Compare." Click twice on 
first station on E(NE) line and note how stations at same distance on other lines 
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are highlighted. Select FUNCTION/'Tlot pressures" and then 
OPTIONS/"Amplitude Scaling"/"Absolute." Select TOOLS/"Clone" and click on 
the first trace. Move the cursor down the page until the color-coded clone 
overlays another trace for comparison. Click to dismiss clone. Select 
PREDICT/"Brode," move yield slider to 30 kt and "Apply." Select 
TOOLS/"Compare" and click once on trace measured at azimuth of 20 degrees to 
obtain a pop-up window listing all waveforms in the database measured at 
comparable scaled distances from comparable scaled HOB explosions. Click on 
all non-Smoky lines in the display and select "OK" to obtain Analyst Station plot 
showing selected Smoky trace (scaled to 1 kt) at top and scaled versions of other 
selected traces below it. Select OPTIONS/ "Amplitude Scaling"/"Absolute." 
Select TOOLS/"Clone" and overlay copy of first trace on others. Select 
PREDICT/"Brode" and "Apply" to compare 1 kt Brode prediction with the 
displayed scaled data. Sequentially "Quit" the two Analyst Station displays to 

return to the main menu. 

(14) Select EVENTS/"Priscilla" and MAGES/"Priscilla detonation." Select 
IMAGES/"Aerial Photos'V'Before test, low elevation." Select 
OVERLAYS/"Before test, low elevation" to identify test structure locations. 
Repeat for other Priscilla aerial photos. 

(15) Select VIEW/"SPOT image, Priscilla" and DATATOverpressure." Select "Cross 
sec" from side menu and sequentially click on a point east of the event and on a 
point at the west end of the instrumentation line. Click on balloon basket to access 
Priscilla event data on the information line. Select STATE/" Select Station" from 
cross-section menu and click twice on each station location box. Select 
FUNCTION/'Tlot pressures" from cross-section menu to obtain Analyst Station 
display of the selected station overpressure waveforms. 

(16) Select PREDICT/"Brode" and click on "Apply" button in Brode dialog box to 
overlay Brode predictions on observed waveforms. Scroll through waveforms. 
Select REFRESH. Iconify Analyst Station window and "Quit" the cross-section 
display. Select MAGES/"Airblast Schematic." De-iconify Analyst Station. Se- 
lect PREDICT/"Non-Ideal" to overlay finite difference predictions on observed 
waveforms. Scroll through waveforms. "Quit" the Analyst Station display. 

(17) Select FUNCTION/Triscilla Airblast Calculation." Select "Cycle" from dialog 
box. Move cursor to frame 8. Select OVERLAY/"Non-Ideal Airblast Schematic." 
Dismiss dialog box. 

(18) Select SERIES/"Teapot" and EVENTS/"Wasp Prime." Sequentially click on 
points north and south of highlighted Wasp Prime location. Click on box next to 
the plane symbol to view event information. Quit the crosssection display. 
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(19) Select EVENTS/"Met" and VIEW/"SPOT image, Met." Select 
DATA/"Overpressure" and OVERLAYS/"Met overlay." Select IMAGES/"Aerial 
photosVWest to tower" and OVERLAYS/"West to tower." Repeat for other Met 
aerial photos. Select VffiW/"SPOT image, Met." Select side menu "Compare" 
and click twice on the fourth desert line station (2000 ft). Select 
FUNCTION/Tlot pressures" and then OPTIONS/"Amplitude 
Scaling"/"Absolute." Select TOOLS/"Clone" and overlay the first (i.e. desert) 
trace on the other two (water and asphalt). Select PREDICT/"Brode" and 
"Apply." Quit Analyst Station display. 

(20) Select SERIES/"Plumbbob" and EVENTS/"Hood." Select "Cross sec" from side 
menu and sequentially click on points north and south of the Hood location. 
Click on balloon baskets to get event information. Quit the cross-section display. 
Select VIEW/" SPOT image, Hood" to see present day collapse craters around 
Hood location on Yucca Flat. 

(21) Select EVENTS/'Tranklin" and VIEW/"SPOT image, Franklin." Select 
DATATOverpressure" and then sequentially click on a point west of Franklin 
location and on a point at the east end of the instrumentation line. Select 
STATE/" Select station" and click twice on closest station. Select FUNCTION/ 
"Plot pressures" and then select PREDICT/ "Lamb" and "Apply." Move Lamb 
instrument height slider to 10 ft and "Apply" to illustrate incorporation of surface 
reflected phase in the LAMB code. Quit the Analyst Station and Cross-section 
displays to return to the main menu. 

(22) Select SEPJES/'Teapot" and IMAGES/"Detonations" and cycle through the 
detonation photos. Select FUNCTION/"Plot peaks" and cycle through the peak 
pressure plots. Cancel event selection dialog box. Repeat for "Plot times" and 
"Cancel" event selection dialog box. Select FUNCTION/'Tlot HOB" and click 
on box to view information regarding that data point. 

(23) Select FUNCTION/"MET Fireball PhotosTCamera 1". Select "Cycle" from 
dialog box. Dismiss dialog box. Repeat for "Camera 2." 

(24) Select "Quit" from main menu to terminate program. 
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APPENDIX C 

A COMPREHENSIVE REFERENCE TO NEDMAS FUNCTIONALITY 

In this section, the capabilities and functionality of the Nuclear Effects Database 
Management and Analysis System (NEDMAS) will be described, with samples of 
displays encountered by a user. A detailed script of the user actions necessary to 
reproduce the sample screens is included as Appendix B. 

C. 1 GENERAL LAYOUT OF NEDMAS APPLICATIONS. 

All applications that are part of NEDMAS have similar appearance. The parts of the 
displays used are as follows: 
• menu bar - an area at the top of the display that contains buttons that cause menus to 

be displayed 
• message area - a strip just under the menu bar that displays short messages from the 

application 
• image area - the main display area of an application 
• side menu area - an area to the right of the image area that contains switches to 

control the functionality of the mouse. When a particular mouse function is selected, 
an indicator is illuminated next to the name of the function. 

These areas are illustrated in Figure C-l. Some NEDMAS applications do not contain all 
areas. 

II   Ivv:  j   |        |                        Menu Bar 

Message Area 

■ t    i 

■ 1    I 
Image Area 

° I ■' i 
Side 

Menu 
Area 

Figure C-l. General layout of NEDMAS applications 

In addition to the areas described above, some actions cause dialog boxes to appear on 
the screen. A dialog box is a temporary window opened by the application to 
communicate information or to request input. Typically, the user responds to a dialog 
box by moving a slider or typing text into an input area, then tells the application to 
proceed by pressing an acceptance button, or to cancel the operation by pressing a cancel 
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button. Some dialog boxes also have associated help text that describes the function of 
the dialog box and the nature of the requested input. Dialog boxes disappear when 
dismissed. 

C.2 THE MAIN IMAGE DISPLAY APPLICATION. 

The main user interface of the NEDMAS application is through an image-display 
application. The layout of this application follows the pattern shown in figure C-l. This 
module provides the mechanism by which much of the general information provided by 
NEDMAS is presented to the user. 

C.2.1 The Menu Bar. 

The menu bar of NEDMAS contains several buttons, most of which cause menus to be 
displayed. The menu buttons are labeled Effect, Series, Events, View, Data, Images, 
Overlays, Function, Copy, Help, and Quit. The Events, View, Data, and Images menus 
are context-sensitive; that is, they contain data relevant to the current state of the 
application. Figure C-2 illustrates the menu bar. 

Efiect    Series   Events   View   Data   images   Overlays   Function   Copy   Help   Quit 
GIS-GEÖSPOT Scene, Panchromatic Image, NTS (resampled 7x) 

Figure C-2. The Main Image Display (MID) main menu and message area. 

The Effect menu will give the user the ability to limit the type of data that will be 
accessed. When fully implemented, it will cause downstream menus, for example the 
Series Menu, to show only those series, events, and so on that contain data of the desired 
effect type. Figure C-3 shows the Effect menu. 

Effect j 
Nuclear Effi^s selection 
Airtüast 
Ground Stock 
Cratertng 
Fireball 

Figure C-3. MID Effect Menu. 

The Series menu allows the user to select which of the several available series of nuclear 
explosion tests is to be examined. As currently configured, the available series are 
Hardtack, Plumbbob, Teapot, Tumbler, Upshot-Knothole, Small Boy, and Sedan. When 
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NEDMAS is first started, none of the Events, View, or Data menus contain any entries; 
the Images and Overlay menus contain a few items that are relevant to NTS as a whole as 
well as some images of general interest. Upon selecting a series, the context-sensitive 
menus fill in with items relevant to the series, and the locations of events from the series 
are shown on the SPOT® image of NTS as icons (red boxes with a center dot to indicate 
the detonation point). To proceed, the user selects one of the available Series from the 
menu. Figure C-4 contains the Series menu for airblast data. 

Series ] 
Series selection 

Hardtack 
Phunbbob 
Teapot 
Tumbler 
Upshot-Knothole 
Small Boy 
Sedan 

Figure C-4. MID Series menu. 

The Events menu is filled in with events from a particular series once a series has been 
selected. Contents of the menu are built from a database of events available to 
NEDMAS. To select an event, the user presses the Events menu button and chooses one 
of the listed events. Upon selection of an event, the context-sensitive menus fill in with 
data relevant to the selected event, while a green diamond outlines the location of the 
event on the SPOT® image. Figure C-5 shows the Events menu for series Teapot. 

Once an event is selected, the View menu fills in with a set of views available for the 
chosen event. As currently configured, NEDMAS provides a full-resolution (10m/pixel) 
SPOT® image of NTS immediately surrounding the event's detonation point, a color- 
coded topographic map of the area around the detonation point, and a general geologic 
map for NTS as a whole. Whichever view the user selects, the application displays the 
image and indicates the location of the event's detonation point with an icon. All views 
chosen in this way are registered to geographic coordinates, so overlaid icons may be 
displayed equally well on all views. Figure C-6 shows the View menu for event MET. 
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Events j 
Event selection 
Apple I 
Apple n 

, B^ 
iHomet 
'Met   ' 
Moth 
Post 
Tesla 
Turk 
Wasp prime 
Zucchini 

Figure C-5. MID Events menu. 

view;] 
VieWjselection. 

g>ÖThBa^,MET 
Topographic data 
Geologic data 

Figure C-6. MID View menu. 

The Data menu contains a list of available data for the selected event. Such data may 
include overpressure, dynamic pressure, total pressure, static pressure, Mach number, 
fireball photography, ground motion, and cratering data as available. Since all data types 
are not available for all events, only the relevant types are shown for a specific event. 
When the user selects a data type from this menu, locations of instruments that collected 
the data are shown on the image, represented by yellow boxes with center dots 
representing the instrument locations. Figure C-7 shows a sample data menu as it would 
appear if all of the effects data types could appear at once. 

Images specific to the chosen event are accessible via the Images menu. The user may 
elect to view any image at any time by selecting one from the menu. After looking at the 
images, the user must restore the View by selecting the appropriate entry from the View 
menu. Selections having a right-pointing arrow on the item bring up a submenu. Figure 
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Data 
Data selection 

Overpressure 
Dynamic Pressure 
Total Pressure 
Static Pressure 
Mach Number 
Ground Morion 
Cratertng 
Fireball Photography 

Figure C-7. MID Data menu. 

C-8 shows a sample Images menu containing two items that would cause submenus to be 
displayed and one item that would display an image. 

Images [ 
Image selection 

Aerial Photos 
Airbiast Schematic 
Instrumentation. 

Figure C-8. ME) Images menu. 

The Overlays menu gives the user access to digitized line data for the specified event. It 
also provides access to data digitized by the user, as discussed below. Figure C-9 shows 
a sample Overlay menu from the MET event. The final entry in each Overlay menu, 
called Digitized overlays, brings up a submenu containing overlays that have been 
constructed via the digitization feature of NEDMAS. 

The Functions menu is partly context-sensitive. That is, its contents do not vary 
according to the selections made in the Series and Events menus, but the data used in 
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Overlays | 
i     Overlay selection 
Met Overlay ■'-. '   ,--.; 
West to Tower 
Northeast to Asphalt 
North to Asphalt 
Northeast to Water 
South to Water 
Digitized overlays 

Figure C-9. MID Overlays menu. 

some displays depends on the selections. Figure C-10 illustrates the Function menu for 

airblast. 

Function 
Function selection 

Hot pressures 
Plot peaks 
Plot tones 
Plot HOB 
PrisciUa Airblast Calculation 
Save overlay ■ 

Figure C-10. MID Functions menu. 

Its contents and their functions include: 
• Plot Pressures - plot pressures as recorded at selected instruments, discussed in more 

detail in section C.4. 
• Plot Peaks - for the selected event, display a plot of Peak Pressure versus Range. 

Discussed in more detail below. 
• Plot Times - for the selected event, display a plot of Arrival Time versus Range. 

Discussed in more detail below. 
• Plot HOB - for the selected event, plot scaled height-of-burst versus scaled range, and 

shows measured peak pressure versus modeled peak pressure in color. Discussed in 
more detail below. 

• Priscilla Airblast Calculation - present graphical results of an off-line finite difference 
calculation for series Plumbbob event Priscilla. The plots show the calculated 
pressure vectors as a function of location versus time after the explosion. 
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•    Save Overlay - this provides a mechanism by which the user can save digitized 
overlays. 

The Copy button on the Menu Bar captures the image to a file. When the user presses 
this button, a dialog box asks for the name of a file to which the screen image is to be 
saved. Screen images are saved to whatever directory the user was in when NEDMAS 
was launched in a form suitable for output to a printer. 

The Help menu provides access to a series of pages of text describing how to use every 
NEDMAS application. Figure C-l 1 shows the Main Image Display help menu. Help 
topics are displayed after selection in a dialog box, as shown in Figure C-l 1. Help topic 
dialog boxes can be scrolled by manipulating a slider on the right side of the text 
window, and can be dismissed via a button at the bottom of the box. 

Help 
Select a help page 

Overview 
Effect Menu 
Series Menu 
Events Menu 
View Menu 
Data Menu 
Images Menu 
Overlays Menu 
Function Menu 
Copy button 
Quit button 
Side buttons and controls. 

NEDMAS is a workstation-based, interactive software system for the 
storage analysis and display of nuclear effects data recorded fro» 
Nevada Teat Site (NTS) atmospheric explosions. The prototype described 
here has been developed by the S-CUBED Division of Maxwell Laboratories 
Inc. under a contract with the Defense Nuclear Agency. This system 
operates off of a test site information interface consisting of a SPOT 
satellite image of NTS and incorporates Defense Happing Agency hioh 
resolution topographic data and U.S. Geological Survey surface geologic 
? 2- .IT, j sfte; K PresentlU incorporates a substantial database 

of digitized airblast recordings and a powerful analyst station which 
per»its the operator to easily access the data recorded fro» particular 
explosions, display them at different scales and Interact with then to 
compare them with other data, as well as with the predictions of different 
theoretical simulation models <l.e. Brode. LAMB, finite difference). 
The principal graphical user interface to the system contains five 
general areas, shown In this schematic: 

Figure C-l 1. MID Help menu and a Help dialog box. 

Pressing Quit causes the application to terminate execution. The Quit button is shown as 
a component of the main menu in Figure C-2. 

C.2.2 Message Area. 

The Main Image Display provides textual output in response to certain actions. If the 
amount of text is small, it is displayed in this area of the display. The message area 
appears just below the main menu, as shown in Figure C-2. 
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C.2.3 Side Menu. 

The behavior of the left mouse button in The Main Image Display varies according to the 
settings of the radio buttons in the side menu. (The name radio buttons derives from car 
radios, meaning that only one of them may be selected at any time.) The radio buttons 
are shown in Figure C-12. A small diamond is associated with the text of each button; 
when the button is selected, the diamond fills with a bright color to indicate the current 

state of the radio buttons. 
Brief descriptions of the actions performed when the left mouse button is pressed when 
the function is enabled are: 
• Information - pressing the left mouse button on an object in the Image Area causes 

information about that object to be displayed. Depending on the amount of 
information available, it may be displayed in the Message Area or in a dialog box. 

• Lat/lon - shows the latitude and longitude of any point in a geo-registered image (i.e., 
a SPOT® image, a color-coded topographic map, or the geologic map). 

• Select Station - allows the user to select data collection stations to be displayed by the 
time-series plotters, discussed below. 

• Compare - allows the user to select data collection stations at similar distances from 
the detonation point by clicking on only one of the stations. Used with the time 
series plotters, discussed below. 

• Digitize - permits the user to digitize arbitrary points on any image. If the image is 
geo-registered, latitude and longitude are used for coordinates; otherwise, pixel 
locations are used. 

• Cross sec - after the selection of two points, plots a vertical cross-section between the 

points. 
• Rotatable Cross sec - similar to Cross sec, but the user selects a center point and an 

endpoint; the length of the line is doubled about the center point and a cross-section 
is displayed. A companion dialog box permits the user to view cross-sections at 
various azimuths about the defined center point. 

• Magnify - presents a magnified view of the area surrounding a mouse-selected point. 
Magnification is controllable to values between 2 and 6 via a companion dialog box. 

The Main Image Display includes some display-altering controls on the side menu 
labeled Contrast and Brightness. These controls alter the contrast and brightness of 
grayscale images by means of sliders. Pressing the Contrast or Brightness buttons 
restores those parameters to their original values. The contrast and brightness controls 

are shown in Figure C-13. 
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* Infomution 

v S*tect Station 

v Compare 

v: Digltire 

vr Cross »ec 

v-Rota table 
Cross aec 

«• Magnify 

Figure C-12. MID side menu. 

i        Contrast       | 

Brighton»«     j 

ir.^-UJi^r 

Figure C-13. MID Contrast and Brightness controls. 

C.2.4 Image Area. 

Almost all of the information communicated by NEDMAS is displayed in the Image 
Area. The user can interact with the image, if appropriate, via the mouse and according 
to the selection in the Side Menu, as discussed above. Many examples of images 
displayed in this region of the Main Image Display are shown in Chapter 2. 

C.3 CROSS-SEC. 

The cross-section display is launched from the main image display application when 
either the Cross sec or Rotatable Cross sec side menu buttons are selected. See the 
discussion under the previous section for more details about creating a cross-section. 
Both methods of creating cross-sections use the same cross-section display application. 
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The cross-section display contains a menu bar, a message area, and an image area. The 
functionality of the mouse is limited to two functions, controlled via a menu from the 
menu bar. Data are taken from a digitized elevation model of the Nevada Test Site. 

C.3.1 Menu Bar. 

The menu bar of the Cross-sec display contains several buttons, some of which cause 
menus to be displayed. The menu buttons are labeled State, Function, Copy, Help, and 
Quit. The contents of all of the menus are static, i.e., they always contain the same 
selections, but the data on which they operate are dependent upon the data included in the 
particular cross-section on display. Figure C-14 shows the menu bar of this application. 

State   Function   Copy   Help   Quit 

Figure C-14. The Cross-section main menu and message area. 

The State menu allows the user to specify the behavior of the left mouse button. The 
default setting is Information. Figure C-15 shows the State menu. 

StateJ 
Select mouse action ! 
Information f 
Select station 

Figure C-15. Cross-sec State menu. 

Brief descriptions of the actions performed when the left mouse button is pressed are: 
• Information - pressing the left mouse button on an object in the Image Area causes 

information about that object to be displayed. Depending on the amount of 
information available, it may be displayed in the Message Area or in a dialog box. 

• Select Station - allows the user to select data collection stations to be displayed by the 
time-series plotters, discussed below. 

The Functions menu is partly context-sensitive. That is, its contents do not vary 
according to the data displayed in the cross-section, but the data available to the Plot 
Pressures application depends upon what is displayed. It contains a single working entry, 
Plot Pressures, that performs the same function as the Functions menu item of the same 
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name described in the previous section, that is, it plots pressures as recorded at selected 
instruments, discussed in more detail in section C.4. The Function menu is illustrated in 
Figure C-16. 

Function j 
Invoke a function 

Plot pressures 
Plot ground motions 
Plot crater profile 
Plot fireball photography 

Figure C-16. Cross-sec Functions menu. 

The Copy button on the Menu Bar captures the image to a file. When the user presses 
this button, a dialog box asks for the name of a file to which the screen image is to be 
saved. Images are saved to whatever directory the user was in when NEDMAS was 
launched. See Figure C-14 for the position of the Copy button on the main menu. 

The Help menu provides access to a series of pages of text describing how to use the 
application. Figure C-17 shows the Cross-sec help menu. Help topics are displayed after 
selection in a dialog box. As discussed above, help text is displayed in a dialog box 
containing a scroll bar and a facility to dismiss the dialog box; see Figure C-l 1 for an 
example of a help dialog box. 

Help j 
Select a help page 
Overview 
State Menu 
Function Menu 
Copy button 
Quit button 

Figure C-17. Cross-sec Help menu. 

Pressing the Quit button causes the application to terminate execution. See Figure C-14 
for the location of the Quit button on the main menu. 
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C.3.2 Image Area. 

The image area of Cross-sec contains a cross-section along the line selected from The 
Main Image Display. Horizontal and vertical scales are shown in the image. The 
vertical exaggeration of the cross-section is determined by the vertical size of the display 
area: cross-sections are scaled to fill the display with a small border at the top and 
bottom. 

If instrument and/or device icons are present and the Information state of the mouse has 
been selected, the user can query the icons for information about the objects represented. 
If the Select Station state of the mouse has been selected, the user can select instruments 
whose data may be displayed by choosing Functions^lot Pressures. 

C.4 ANALYST STATION TIME SERIES ANALYSIS MODULE. 

The analyst station displays time series versus elapsed time from the beginning of the 
digitized record. The display contains a main menu bar, a message area, and an image 
area containing one or more plots of time series. If there are more time series than will 
fit on a single screen, a scrollbar will appear along the right edge of the image area; the 
user can drag the scrollbar down to see time series that didn't fit on the initial display. 
Each time series is plotted in its own window, including amplitude and elapsed time 
scales along with text indicating the range, azimuth from detonation point, elevation of 
instrument, environment, and installing organization. Data are taken from digitized 
waveform files. 

C.4.1 Menu Bar. 

The menu bar of the analyst station contains menu buttons labeled Predict, Options, 
Tools, and Help, and three action buttons, labeled Refresh, Copy, and Quit. The menus 
are static but operate on the data included in the analyst station when it is launched. 

Predict Options Tools Refresh Copy Help Quit 
PLUMBBOB, SMOKYJW = 43.7W, HOB = 700ft),, Ove^ssureJpsj)^ 

Figure C-l8. Analyst Station menu bar. 

The Predict menu gives the user access to a variety of airblast and ground motion 
models. Choosing an option from this menu will cause a model to be calculated, if 
appropriate, and displayed as an overlay to each time series so that the user may compare 
modeled time series with measured data. Figure C-19 shows this menu. 
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Predict] 
Model 

Brode (1988) 
LambTlM^" 
Non-Ideal 

Figure C-19. Analyst Station Predict menu. 

The models available are: 

Brode (1988) - Upon choosing this airblast model, a dialog box appears in which the user 
can select yield and height-of-burst by means of sliders; initial settings of these 
parameters match those for the event being displayed in the analyst station. If the user 
elects to continue, pressing the Apply button at the bottom of the dialog box causes the 
application to calculate and plot the model for each yield and range represented in the 
display. Pressing Cancel on the dialog box dismisses it. Figure C-20 shows this dialog 
box. 

f'ETTTH        ^™"ii«^™>»i 
Select parameters for Brode 

43.7 
model 

i 

"Held(kt) 

700 

Help! 

HOB(ft) 

Apply! Cancel! 

Figure C-20. Brode model parameters dialog box. 

LAMB (S-Cubed 1983) - Upon choosing this airblast model, a dialog box appears in 
which the user can select yield, height-of-burst, and height of instrument by means of 
sliders; initial settings of the first two parameters match those for the event being 
displayed in the analyst station, while the initial setting for height of instrument is 
always zero. Pressing the Apply button at the bottom of the dialog box causes the 
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application to calculate and plot the model for each yield and range represented in the 
display. Pressing Cancel in the dialog box dismisses it. The dialog box is illustrated 
in Figure C-21. 

Select parameters for Lamb model 

43.7 

Yield(kt) 

700 

HOB(ft) 

0 

Helght(ft) 

Apply! Cancel! Help! 

Figure C-21. LAMB model parameters dialog box. 

• Non-ideal (Needham et al., 1994) - This airblast model incorporates a more realistic 
set of parameters and more elaborate modeling techniques than either the Brode or 
LAMB models. It was calculated offline on a supercomputer; therefore only the 
results are available in NEDMAS. Time series for this model are available for only 
one event: series Plumbbob, event Priscilla. 

• Ground motion - this model provides access to offline theoretical ground motion 
simulation results for selected events. 

The presentation of the data by the analyst station can be manipulated via the Options 
menu   In all cases, choosing an entry from this menu brings up a secondary menu from 
which the user may make a selection.   Figure C-22 shows this menu and its submenus. 

The options available are: 
• Amplitude Scaling - the way the pressure axes of the several time series are 

presented. 
0   Relative scaling (the default) - each time series is drawn so that it fills its display 

window, i.e., is scaled to a unique size based on its maximum pressure value 
0   Absolute scaling - all time series in a display are scaled to the maximum pressure 

shown in the display, so that the pressures shown in different times series may be 
compared more meaningfully. 

• Yield Scaling - controls whether pressure data are presented as recorded or 
normalized to an event of standard size 
0   No scaling - pressure data are presented as they were recorded 
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W1/3 - pressure data are scaled according to a cube-root scaling law to normalize 
all explosions to a standard event, namely 1 kiloton at sea level. This is useful in 
comparing time series from different events. 

Options | 
Select Option 

Amplitude Scaling r- 
Yield Scaling         , 
Units 

Options] 
Select Option 

Amplitude Scaling' 
Yield Scaling 
Units 
Trace Type 

Trace Type 

Options! 
Select Option 

Amplitude Scaling . 
Yield Scaling         r 

" Amplitude scaling! 
Relative                j Yield Scaling! 
Absolute Units 

Trace Type 

Options! 
Select Option 

Amplitude Scaling 
Yield Scaling 
Units 
Trace Type            i 

No Scaling   j 
' Wl/3           j 

Optionsj 
Select Option 

Amplitude Scaling 
Yield Scaling 
Units 
Trace Type 

! 
:\ 

■■! 
j 

Units 
' Original (ft.psi) 

1 Standard (mjdPa) 

i 
Select Type' 
Pressure    j 
Impulse     j 

Figure C-22. Analyst Station Options menu and its submenus. 

• Units - specifies the units in which pressure and distance data are presented 
0   Original (ft, psi) - data are presented in the English units feet and pounds per 

square inch 
0    Standard (m, kPa) - data are presented in SI units meters and kiloPascals 

• Trace Type - determines whether pressure data are shown as instantaneous pressure 
or as accumulated total pressure 
0   Pressure - data are shown as instantaneous pressure over time, in units of pressure 
0   Impulse - data are shown as pressure integrated over time, in units of pressure- 

time 

The Tools menu allows the user to interact with the data in various ways. This menu is 
shown in Figure C-23. 

The choices available are: 
• Expand - produces a full-page display of any selected time series. A second instance 

of the analyst station is started to display this single time-series, so all other 
functionality of the analyst station may be brought to bear on the trace. 
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Clone - produces a moveable colored copy of any selected time series. The user may 
then drag the copy around the display to overlay it on another time series to examine 
similarities. The first mouse-click selects the trace to be copied; a second mouse 

Tools j 
Select Tool 
Expand 
äone 
Measure 
Compare 
Plot Peaks 
Plot Times 
Plot HOB 

Figure C-23. Analyst Station Tools menu. 

click dismisses the copy. If the user holds the left mouse button down after the first 
click, the copy will move smoothly over the display; alternatively, if the user releases 
the left mouse button after the first click, the copy will jump from location to location 
after a computer-system-set threshhold time has passed. 
Measure - allows the user to measure pressure and elapsed time anywhere on a time 
series plot. To use this, move the mouse cursor to the desired location on the trace 
and press the right mouse button. Note that one can measure pressure and time at any 
location in the time series display window, not just on the waveform. 
Compare - upon selecting the Compare tool and clicking on a time series, the 
application searches the database for pressure measurements taken at similar scaled 
heights of burst and scaled range. A dialog box will appear that contains a list of all 
time series matching the search criteria, with the original trace shown at the top. The 
user can select individual time series for display by clicking once on each desired 
time series, and can deselect time series by clicking a second time on it. 
Alternatively, there are Select All and Deselect All buttons at the bottom of the dialog 
box that can be used. When the user is satisfied with the selection of time series, 
press the Ok button at the bottom of the dialog box to start a second instance of the 
analyst station that shows the selected similar time series for comparison to the 
original time series. 
Plot Peaks - for the selected event, display a plot of Peak Pressure versus Range. 
Discussed in more detail below. 
Plot Times - for the selected event, display a plot of Arrival Time versus Range. 
Discussed in more detail below. 
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•   Plot HOB - for the selected event, plots scaled height-of-burst versus scaled range, 
and shows measured peak pressure versus modeled peak pressure in color. Discussed 
in more detail below. 

The Refresh button causes the display to be redrawn. This button is visible on Figure 
C-18. 

The Copy button on the Menu Bar captures the image to a file. When the user presses 
this button, a dialog box asks for the name of a file to which the screen image is to be 
saved. Images are saved to whatever directory the user was in when NEDMAS was 
launched. See Figure C-18. 

The Help menu provides access to a series of pages of text describing how to use the 
application, as described in previous sections. The Help menu is shown in Figure C-24. 

Help! 
Help 

Overview 
Predict Menu 
Options Menu 
Tools Menu 
Refresh Button 
Copy Button 
Quit Button 

Figure C-24. Analyst Station Help menu. 

Pressing Quit causes the application to terminate execution. 

C.4.2 Image Area. 

Plots of time series are displayed here. Each time series is displayed in its own 
subwindow. If there are too many time series to be displayed at reasonable size on the 
screen, a vertical slider at the right side of the image area enables the user to scroll the 
display to view more time series plots. 

C.5 COMPARE. 

The time series comparison module is a specialized version of the analyst station, 
dedicated to displaying results of the Tools^Compare operation from the analyst station. 
Labels of individual time series contain both observed and scaled values, and the menus 
contain a subset of the options available under the analyst station. See section C.4 for 
more information. 
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C.6 PLOTPEAKS. 

This application is launched by choosing Function^Plot Peaks from the Main Image 
Display. It shows peak pressures at all instruments as a function of range from the 
detonation point. The display comprises a menu bar, a message area, and an image area. 
Data are taken from a database table. 

C.6.1 Menu bar. 

The menu bar in PlotPeaks contains two menu buttons and three action-producing 
buttons. The menu buttons are Units and Help, while the action-producing buttons are 
Refresh, Copy, and Quit. See Figure C-25. 

Units Refresh Copy Help Quit 
"pLUMBBOB, smoky (W = 43.7M, HOB = 70^)^^5?!f™L*SL 

Figure C-25. PlotPeaks main menu and message area. 

The Units menu allows the user to specify the units in which pressure and distance data 
are presented. This menu is illustrated in Figure C-26. The choices are: 
• Original (ft, psi) - data are presented in the English units feet and pounds per square 

inch 
• Standard (m, kPa) - data are presented in SI units meters and kiloPascals. 

Unttsj 
Units | 

Cttigin^j^jpsi)^! 
Standard (mJ«Pa)| 

Figure C-26. PlotPeaks Units menu. 

The Refresh button causes the display to be redrawn. 

The Copy button on the Menu Bar captures the image to a file. When the user presses 
this button, a dialog box asks for the name of a file to which the screen image is to be 
saved. Images are saved to whatever directory the user was in when NEDMAS was 
launched 
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The Help menu provides access to a series of pages of text describing how to use the 
application. See Figure C-l 1 for an example. 

Pressing Quit causes the application to terminate execution. 

C.6.2 Image Area. 

The image area contains a plot of peak pressure versus range. It shows the peak pressure 
at each instrument as a box, and additionally has the results of Brode and LAMB 
modeling plotted. The user can interrogate each instrument by clicking on its box with 
the mouse; the instrument under examination is highlighted with a blue diamond. The 
result of the interrogation shows up as a dialog box, and the user must dismiss the dialog 
box via its OK button before another instrument can be interrogated. There's no 
provision for selecting among many instruments when they lie too close together on the 
plot, so in some cases it's not possible to find out about certain instruments. Clicking on 
a location away from the boxes (i.e., in the background area of the plot) interrogates 
whatever instrument is closest to the mouse click. 

C.7 PLOTTIMES. 

This application displays the time of first positive pressure in milliseconds after 
detonation, as measured from the original data. The data come from a database. 

C.7.1 Menu bar. 

The menu bar in PlotPeaks contains two menu buttons and three action-producing 
buttons. The menu buttons are Units and Help, while the action-producing buttons are 
Refresh, Copy, and Quit. 

Units Refresh  Copy Help Quit                                                                                                                              I 

_^             PLUMBBOB, smoky (W = 43.7kt, HOB = 700ft), Peak Pressure (psl) 

Figure C-27. Plot Times Main Menu and Message Area. 

The Units menu allows the user to specify the units in which pressure and distance data 
are presented. The choices are: 
• Original (ft, psi) - data are presented in the English units feet and pounds per square 

inch 
• Standard (m, kPa) - data are presented in SI units meters and kiloPascals 
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The Refresh button causes the display to be redrawn. 

The Copy button on the Menu Bar captures the image to a file. When the user presses 
this button, a dialog box asks for the name of a file to which the screen image is to be 
saved. Images are saved to the directory the user was in when NEDMAS was launched. 

Units j 
Units ■ 

Original (ft.psi)  \ 
Standard (mJcPa) 

Figure C-28. Plot Times Units menu. 

The Help menu provides access to a series of pages of text describing how to use the 
application. See Figure C-l 1 for an example. 

Pressing Quit causes the application to terminate execution. 

C.7.2 Image Area. 

The image area contains a plot of the time of first arrival after detonation versus range. 
It shows the arrival time at each instrument as a box, and additionally has the results of 
Brode and LAMB modeling plotted. The user can interrogate each instrument by 
clicking on its box with the mouse; the instrument under examination is highlighted with 
a blue diamond. The result of the interrogation shows up as a dialog box, and the user 
must dismiss the dialog box via its OK button before another instrument can be 
interrogated. There's no provision for selecting among many instruments when they lie 
too close together on the plot, so in some cases it's not possible to find out about certain 
instruments. Clicking on a location away from the boxes (i.e., in the background area of 
the plot) interrogates whatever instrument is closest to the mouse click. 

C.8 PLOTHOB. 

This application shows three dimensions of data in a 2D display by using color. The 
horizontal axis is ground range scaled by a cube-root scaling law, and the vertical axis is 
height-of-burst, also scaled by a cube-root relation. The background of the display is a 
color contour map of pressure as a function of height of burst and range, as calculated by 
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the Brode model (Brode 1986). Scaled measurements from individual events are shown 
as boxes overlying the background contour map to allow comparison of measurements 
with the model. 

PlotHOB has a menu bar, a message area, a side menu area, and an image display area. 

C.8.1 Menu Bar. 

The menu bar contains one menu trigger and two action-inducing buttons. The menu bar 
is shown in Figure C-29. 

Copy   Help   Ojiit 

HOB vs Range, IM Ernst, Maximum Overpressure 

Figure C-29. PlotHOB main menu and message area. 

The Copy button on the Menu Bar captures the image to a file. When the user presses 
this button, a dialog box asks for the name of a file to which the screen image is to be 
saved. Images are saved to whatever directory the user was in when NEDMAS was 
launched 

The Help menu provides access to a series of pages of text describing how to use the 
application. See Figure C-l 1 for an example. 

Pressing Quit causes the application to terminate execution. 

C.8.2 Side Menu Area. 

The behavior of the left mouse button in PlotHOB varies according to the settings of the 
radio buttons in the side menu. (The name radio buttons derives from car radios, 
meaning that only one of them may be on at any time.) Figure C-30 illustrates the side 
menu. The radio buttons, and brief descriptions of the actions performed when the left 
mouse button is pressed when the function is enabled, are: 

• Information - when the user clicks on a measurement box, the name of the event 
during which the measurement was made is displayed in the message area, and a 
dialog box appears that reports information about the scaled data resulting from the 
measurement. There is no provision for choosing a particular measurement from 
among a series that are closely located on the plot. 
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Range, HOB - reports the scaled range and height-of-burst of a particular background 

Expand - displays a dialog box with text boxes containing settings for X Start and X 
End Y Start and Y End. When this dialog box is visible, the user can draw a box 
around an area of interest on the PlotHOB display, select OK on the dialog box, and 
see a full-screen expansion ofthat area. This is the only way to examine individual 
data points in crowded areas. There's no provision to get back to the full-screen 
display; the user must quit PlotHOB and restart it. 

Figure C-30. PlotHOB side menu. 

C.8.3 Image Area. 

PlotHOB displays data in three dimensions: scaled range (horizontal component of 
distance of the instrument from the detonation point) and scaled height-of-burst are 
shown as horizontal and vertical axes, while scaled pressure is represented by a color 
keyed to a colorscale that appears at the right side of the image area. Color-coded boxes 
indicate individual instruments mapped into this scaled space. A color contour map of 
scaled pressure calculated by the Brode model (Brode 1986) is used as background. 
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APPENDIX D 

TRADEMARKS 

Motif is a trademark of the Open Software Foundation, Inc. 

Netscape and Netscape Navigator are registered trademarks of Netscape Corporation, Inc. 

Oracle is a trademark of Oracle Corporation, Inc. 

SPOT is a trademark of CNES/SPOT Image Corporation, Inc. 

SPOT data copyright CNES/SPOT Image Corporation, Inc. 

Sun SPARCStation is a trademark of Sun Microsystems, Inc. 

UNIX is a registered trademark of AT&T Bell Laboratories, Inc. 

X Window System is a trademark of the Massachusetts Institute of Technology. 
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2 CY ATTN: LIBRARY EM-08 

LOGICON R AND D ASSOCIATES 
ATTN: DR T A PUCIK 
ATTN: G IVY 

2 CY ATTN: LIBRARY 

LOGICON R AND D ASSOCIATES 

ATTN: A POLK 
ATTN: D PIEPENBURG 
ATTN: DOCUMENT CONTROL 
ATTN: TOM MAZZOLA 

LOGICON R AND D ASSOCIATES 
ATTN: G GANONG 
ATTN: L GERMAIN 

LOGICON R AND D ASSOCIATES 
ATTN: D PIEPENBURG C/O TERRI 

BOZARTH 

LORAL FEDERAL SYSTEM - OWEGO 
2 CY   ATTN: DEPT L75, MAIL DROP 0306 

LORAL SPACE & RANGE SYSTEMS 
ATTN: J ANBDRES 

MAGNAVOX ELECTRONICS SYSTEMS COMPANY 

2 CY ATTN: LIB, C A FONTANA 

MARTIN MARIETTA 
ATTN: 410 - 2 - C19, R HERSCMITZ 

MARTIN MARIETTA DENVER AEROSPACE 
ATTN: D HAMPTON 
ATTN:DWICKERSHEIM 
ATTN: RESEARCH LIBRARY 

MASSACHUSETTS INSTITUTE OF TECHNOLOGY 
ATTN: V - 275, V SFERRINO 

MAXWELL FEDERAL DIVISION, INC 
ATTN: DR JASON WILKENFELD 

MAXWELL LABORATORIES, INC. 
ATTN: J NORTHROP 

MAXWELL TECHNOLOGIES 
ATTN: PHIL COLEMAN 

MAXWELL TECHNOLOGIES INC 
2 CY ATTN: BRIAN W BARKER 

ATTN: D DE CASTRO 
2 CY ATTN: DENNIS C O'NEILL 

ATTN: H FROIBERG 
ATTN: J BARTHEL 

2 CY ATTN: JOHN R MURPHY 
ATTN:KDPYATT,JR 
ATTN: M HIGGINBOTHAM 
ATTN: R LAFRENZ 
ATTN: R SANDMAN 
ATTN: S PEYTON 

MCDONNELL DOUGHLAS CORPORATION 
ATTN: R HALPRIN 

METATECH CORP. 
ATTN: C JONES 

METATECH CORPORATION 
ATTN:WARADASKY 

MISSION RESEARCH CORP 
ATTN: W WHITE 

MISSION RESEARCH CORP. 
ATTN: DOCUMENT CONTROL 

MISSION RESEARCH CORP. 
ATTN: SURVIVABLE STRUCTURES 

TECHNOLOGIES DIV 

MITRE CORPORATION 
ATTN: A MONTGOMERY 

2 CY ATTN: ASST MGR CORPORATE INFO SVCS 

MITRE CORPORATION 
ATTN: E NICOSIA 
ATTN: LIBRARY 

NICHOLS RESEARCH CORPORATION 
ATTN: R BYRAN 

Dist-6 



DSWA-TR-96-94 (DL CONTINUED) 

PACIFIC-SIERRA RESEARCH CORP. 
ATTN: G ANNO 
ATTN: H BRODE 

PACIFIC-SIERRA RESEARCH CORP. 
ATTN: G MCCLELLAN 

PHOTO METRICS, INC 

ATTN: DOCUMENT CONTROL 

PHYSITRON INC 

ATTN: RON SKARUPA 

PRIMEX PHYSICS INTERNATIONAL 
ATTN: LIBRARY 

RAYTHEON - MSD 
ATTN: LIBRARY T3MA13 

RAYTHEON CO. 
ATTN: B SCHUPP 
ATTN: DOC CONTROL FOR B W SCHUPP 

RESEARCH TRIANGLE INSTITUTE 
ATTN: M SIMONS 

ROCKWELL INTERNTIONAL CORP. 
ATTN: MCEA22, E BARKAUSKAS 

ROCKWELL INTERNATIONAL CORP. 
ATTN: R L BOWERSOX 

ROCKWELL INTERNATIONAL CORP. 
ATTN: TECHNICAL INFO CENTER 

ROCKWELL INTERNATIONAL CORP. 
ATTN: NUC EFFECTS ENGRG HB - 13 

SANDERS 
ATTN: BRIAN CARRIG 

SCHAEFFER ASSOCIATES 
ATTN: N SCHAEFFER 

SCI TECHNOLOGY, INC 
ATTN: DOCUMENT CONTROL 

2CY  ATTN: HAROLD L JACKSON 

SCIENCE & ENGRG ASSOCIATES, INC. 
ATTN: J CRAMER 

SCIENCE & ENGRG ASSOCIATES, INC. 
ATTN: RANDY BEATTY 

SCIENCE APPLICATIONS INTERNATIONAL CORP 
ATTN: RICHARD HILLENDAHL 

SCIENCE APPLICATONS INTL CORP 
ATTN: D KAUL 
ATTN: D SACHS 
ATTN: FAC SCTY SUPV/J LINN, F3 
ATTN: G EGGUM 
ATTN: H WILSON 
ATTN: J DISHON 
ATTN: L SCOTT 
ATTN: MARVIN DRAKE 
ATTN:R J BEYSTER 
ATTN: TECH LIBRARY 
ATTN: TECHNICAL REPORT SYSTEM 
ATTN:W LEE 

SCIENCE APPLICATIONS INTL CORP 
ATTN: SECURITY OFFICE 

SCIENCE APPLICATIONS INTL CORP 
ATTN: SECURITY OFFICE 

SCIENCE APPLICATIONS INTL CORP 
ATTN: CARL BIOEMKER 
ATTN: R MILLER 

SCIENCE APPLICATIONS INTL CORP 
ATTN: B L BEERS 
ATTN: J MCGAHAN 
ATTN: J PEDEN 
ATTN: J TIGNER 
ATTN: JOHN RETZLER 
ATTN: W LAYSON 

SCIENCE APPLICATIONS INTL CORP 
ATTN: TECH LIBRARY 

SCIENCE APPLICATIONS INTL CORP 
ATTN: R L HOOVER 

SCIENCE APPLICATIONS INTL CORP 
ATTN: G BINNINGER 
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SCIENCE APPLICATIONS INTL CORP 

ATTN: RICHARD A KITTER 

SCIENCE APPLICATIONS INTL CORP 
ATTN: K SITES 

SOUTHERN RESEARCH INSTITUTE 

ATTN: C PEARS 

SPERRY CORP 
ATTN: ENGRG LIB, C MARCOX 

SRI INTERNATIONAL 
ATTN: DOCUMENT CONTROL AE031 

SYSTEM PLANNING CORP. 

ATTN: R NAGLER 
ATTN: R SCHEERBAUM 

2 CY ATTN: RESEARCH LIBRARY 
ATTN: W GOLBITZ 

TELEDYNE BROWN ENGINEERING 
ATTN: TECH LIB, MARK SUTHERLAND 
ATTN: TECHNICAL LIBRARY, P SHELTON 

TEXAS INSTRUMENTS 
ATTN: C KAMRADT 

THE AEROSPACE CORP 

ATTN: H BLAES 
ATTN: H MIRELS 
ATTN: LIBRARY ACQUISITION 

THE BDM CORPORATION OF SAUDI ARABIA 

ATTN: E DORCHAK 
ATTN: JOSEPH BRADDOCK 

TITAN RESEARCH & TECHNOLOGY DIVISION 

ATTN: J THOMSEN 

TITAN CORPORATION 
ATTN: DOCUMENT CONTROL 

TITAN CORPORATION (THE) 
ATTN: ANNE COOPER 

ATTN: LIBRARY 
ATTN: PDOWELL 
ATTN: S SCHUSTER 

TOYON RESEARCH CORP. 
ATTN: DOCUMENT CONTROL 

TRACOR, INC. 
ATTN: DR MATHUR 

TRW INC. 
ATTN: T. I.C., S/1930 

TRW SPACE & DEF SEC SPACE & TECH GRP 
ATTN: D M LAYTON 
ATTN: OUT6, W WAMPLER 

VISIDYNE, INC 
ATTN: T STEPHENS 

VISIDYNE, INC. 
ATTN: J CARPENTER 
ATTN: W SCHLUETER 

WEILDLINGER ASSOCIATES, INC. 
ATTN: H LEVINE 

WEIDLINGER ASSOCIATES, INC 

ATTN: T DEEVY 

WEIDLINGER ASSOCIATES, INC. 

ATTN: J WRIGHT 
ATTN: P WEIDLINGER 
ATTN: RAYMOND P DADDAZIO 
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